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Release Notes for Cisco ViewMail for Microsoft Outlook
Release 11.5(1)
These release notes contain requirements, download, installation, configuration instructions, new and changed requirements, support,
limitations and restrictions, and caveat information for Cisco ViewMail for Microsoft Outlook Release 11.5(1).

ViewMail for Outlook 11.5(1) is available only from the Cisco Download Software website.

For full access to the Download Software website, you must be signed in to Cisco.com as a registered
user.
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Introduction
Cisco ViewMail for Microsoft Outlook provides a visual interface with which users can send, listen to, and manage their Cisco Unity
Connection voice messages from Outlook.

Note the following considerations with ViewMail for Outlook:
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• Users get voice messages in the same Inbox as their
email.

• Voice messages sent from Outlook do not appear in the
Sent Items folder.

• ViewMail for Outlook is not required with the
single-inbox feature.Without it, however, users can only
play voice messages; they cannot compose, reply to, or
forward them.

• ViewMail for Outlook is required for users to play secure
messages in the Exchange mailbox.

Single-inbox users

• Users get voice messages in a separate mail folder in
Outlook.

• New voice messages get identified by a separate voice
message icon.

• ViewMail for Outlook is required for users to play secure
messages in the Unity Connection mailbox.

IMAP users

Note • On Windows operating system with ViewMail for Outlook, the text of the voice messages appears
in black color and the ViewMail category appears in blue color. However, onMAC operating system,
the text of the voice messages and the ViewMail category appears in the system default color.

•When there is no default recording device available on theWindowsmachines and the user selectsthe
recording device from Phone to Computer Default option then ViewMail for Outlook will always
consider Phone as default recording device.
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Requirements

Note • The ViewMail for Outlook version must be supported with the version of Outlook that is installed
and the operating system. See the applicable documentation:

◦The “ViewMail with Unity Connection 11.x and Cisco Business Edition 6000/7000” section
of Compatibility Matrix for Cisco Unity Connection at http://www.cisco.com/c/en/us/td/docs/
voice_ip_comm/connection/compatibility/matrix/cucclientmtx.html.

• The following software installed on the user workstation:

◦Microsoft DirectX 9.0

◦Microsoft .NET Framework 3.5

◦Microsoft Visual C++ 2008 Redistributable Package

(If the software is not already installed, ViewMail for Outlook Setup installs it.)

• To install or upgrade ViewMail for Outlook, you must have local administrator rights on the user
workstation.

• The user workstationmust have at least 10MB of hard-disk space available for ViewMail for Outlook.
(If other required software is being installed,100 MB or more may be required.)

• If the proxy is enabled on the user workstation, then it must be connected to port 443 (HTTPS) to
allow the communication between ViewMail for Outlook and Cisco Unity Connection.

See also the “Prerequisites” section of these release notes.

Compatibility Information
• For information on all qualified version combinations of ViewMail for Outlook, Cisco Unity Connection, and the software on
user workstations, see Compatibility Matrix for Cisco Unity Connection at http://www.cisco.com/en/US/docs/voice_ip_comm/
connection/compatibility/matrix/cucclientmtx.html. The document also contains the support policy for software on user
workstations.

• For a list of all languages available for ViewMail for Outlook, see the “Available Languages for Cisco Unity Connection
Components” section of System Requirements for Cisco Unity Connection Release 11.x at http://www.cisco.com/c/en/us/td/
docs/voice_ip_comm/connection/11x/requirements/11xcucsysreqs.html.

Determining the ViewMail for Outlook Version
To Determine the ViewMail for Outlook Version in Use from Outlook

In Outlook on the user workstation:

On the ViewMail tab, select About Cisco ViewMail.Outlook 2010 and above
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From the Help menu, select Cisco ViewMail for Outlook > About Cisco
ViewMail.

Outlook 2007

Related Documentation
For descriptions and URLs of Cisco Unity Connection documentation on Cisco.com, see the Documentation Guide for Cisco Unity
Connection Release 11.x. The document is shipped with Unity Connection and is available at http://www.cisco.com/en/US/docs/
voice_ip_comm/connection/11x/roadmap/11xcucdg.html. Note

The Quick Start Guide for Cisco ViewMail for Microsoft Outlook (Release 8.5 and Later) is available at
http://www.cisco.com/en/US/docs/voice_ip_comm/connection/vmo/quick_start/guide/85xcucqsgvmo.html.

Note

New and Changed Requirements and Support—Release 11.5(1)
This section contains information about new and changed and requirements and support in the 11.5(1) release time frame only.

You can enter a special character multiple times as per your requirements.Note

Additional Languages for ViewMail for Outlook
All locales are released for ViewMail for Outlook 11.5(1) release.

For a list of all languages available for ViewMail for Outlook, see the “Available Languages for Cisco Unity Connection Components”
section of System Requirements for Cisco Unity Connection Release 11.x at http://www.cisco.com/c/en/us/td/docs/voice_ip_comm/
connection/11x/requirements/11xcucsysreqs.html.

New and Changed Functionality—Release 11.5(1)
This section contains information about new functionality in the ViewMail For Outlook 11.5(1) release.

(For information on new and changed requirements and support in earlier versions of Cisco Unity Connection ViewMail forMicrosoft
Outlook, see the applicable release notes at http://www.cisco.com/en/US/products/ps6509/prod_release_notes_list.html.)

Support for Outlook 2016
Beginning with release 11.5(1) and later, ViewMail for Outlook supports Outlook 2016 as well.

Location for Voice Message Button Changed
In Outlook, now the Voice Message button appears on the Untitled Message (HTML) page that is displayed when you create a new
message.
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Installation and Upgrade Information
• Task List for Installing ViewMail for Outlook 11.5(1) for the First Time, on page 6

• Task List for Upgrading to ViewMail for Outlook 11.5(1), on page 6

• Prerequisites, on page 7

• Downloading ViewMail for Outlook 11.5(1), on page 9

• Customizing ViewMail for Outlook Setup, on page 9

• Installing or Upgrading to ViewMail for Outlook 11.5(1), on page 10

• Installing ViewMail for Outlook 11.5(1) Using Command Line Switches, on page 10

• Associating the Applicable Email Account with the Voicemail Server, on page 11

Task List for Installing ViewMail for Outlook 11.5(1) for the First Time
Do the following tasks in the order listed for a new ViewMail for Outlook installation.

1 Confirm that ViewMail requirements and prerequisites have been met. See the “Requirements” section and the “Prerequisites”
section.

2 Download ViewMail for Outlook from the Cisco Download Software website. See the “Downloading ViewMail for Outlook
11.5(1), on page 9” section.

3 Optional: Customize ViewMail for Outlook setup. See the “Customizing ViewMail for Outlook Setup, on page 9” section.
4 Optional: Provide users with ViewMail for Outlook files for installation.
5 Install ViewMail for Outlook. Provide users with instructions, if applicable. See the “Installing or Upgrading to ViewMail for

Outlook 11.5(1), on page 10” section.
6 Link users’ email accounts with the voicemail server:

a Using the ViewMail for Outlook Initialization wizard: When they restart Outlook following ViewMail installation, the
Initialization wizard prompts users for any required information that was not already prepopulated.

b Using the ViewMail Options or Settings dialog: Enter the required information. Provide users with instructions, if applicable.
See the “Installing ViewMail for Outlook 11.5(1) Using Command Line Switches, on page 10” section.

Task List for Upgrading to ViewMail for Outlook 11.5(1)

If you are upgrading from a ViewMail for Outlook version earlier than 11.5(1), see the “Task List for
Installing ViewMail for Outlook 11.5(1) for the First Time, on page 6” section. The older version is
uninstalled automatically, and installing 11.5(1) is considered a new installation.

Note

Do the following tasks in the order listed to upgrade ViewMail for Outlook to a later version.Note

1 Confirm that ViewMail requirements and prerequisites have been met. See the “Requirements, on page 4” section and the
“Prerequisites, on page 7” section.
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2 Download ViewMail for Outlook from the Cisco Download Software website. See the “Downloading ViewMail for Outlook
11.5(1), on page 9” section.

3 Optional: Customize ViewMail for Outlook setup for the upgrade, if applicable. See the “Customizing ViewMail for Outlook
Setup, on page 9” section.

4 Optional: Provide users with ViewMail for Outlook files for the upgrade.
5 Upgrade ViewMail for Outlook. Provide users with instructions, if applicable. See the “Installing or Upgrading to ViewMail for

Outlook 11.5(1), on page 10
6 Installing or Upgrading to ViewMail for Outlook 11.5(1), on page 10” section.

Existing email account and ViewMail for Outlook settings remain unchanged during an upgrade.Note

Prerequisites
• Prerequisites for Using ViewMail for Outlook with the Single-Inbox Feature, on page 7

• Prerequisites for Using ViewMail for Outlook with IMAP, on page 7

• Creating and Configuring an Account in Outlook to Access Voice Messages (IMAP Users Only), on page 8

Prerequisites for Using ViewMail for Outlook with the Single-Inbox Feature

For ViewMail for Outlook users who will access Unity Connection voice messages by using synchronized Unity Connection and
Microsoft Exchange mailboxes(single-inbox), confirm that the following prerequisites have been met:

• The single-inbox feature is enabled.(See the Unified Messaging Guide for Cisco Unity Connection Release 11.x at http://
www.cisco.com/en/US/docs/voice_ip_comm/connection/11x/unified_messaging/guide/11xcucumgx.html.)

• An Exchange email account in Outlook points to each user’s Exchange mailbox.

Prerequisites for Using ViewMail for Outlook with IMAP

For ViewMail for Outlook users who will access Unity Connection voice messages by using IMAP, confirm that the following
prerequisites have been met:

• Users’ corporate email addresses are configured as SMTP proxy addresses.
(See the “Users” chapter of chapter of the System Administration Guide for Cisco Unity Connection Release 11.x at http://
www.cisco.com/c/en/us/td/docs/voice_ip_comm/connection/11x/administration/guide/11xcucsagx.html.)

• Users are associated with a class of service enabled for accessing voice messages by using an IMAP client.
(See the “User Attributes” chapter of the System Administration Guide for Cisco Unity Connection Release 11.x.)

• The Unity Connection server is configured to allow SMTP connections from IMAP clients.
(See the Unified Messaging Guide for Cisco Unity Connection Release 11.x at http://www.cisco.com/c/en/us/td/docs/
voice_ip_comm/connection/11x/unified_messaging/guide/11xcucumgx.html.)

• If Transport Layer Security for untrusted IP addresses is configured to be required or optional: The Connection server is
configured to provide a secure IMAP connection.
(See the Security Guide for Cisco Unity Connection Release 11.x at http://www.cisco.com/c/en/us/td/docs/voice_ip_comm/
connection/11x/security/guide/11xcucsecx.html.)
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• An IMAP email account is configured in Outlook for each ViewMail for Outlook user.
(See the “Creating and Configuring an Account in Outlook to Access Voice Messages (IMAP Users Only)” section on page 6
of these release notes.)

Creating and Configuring an Account in Outlook to Access Voice Messages (IMAP Users Only)

Do the applicable procedure—depending on the Outlook version—for ViewMail for Outlook users who will access Connection voice
messages by using IMAP:

• To Create and Configure an Account in Outlook 2010 and later to Access Voice Messages (IMAP Users)

• To Create and Configure an Account in Outlook 2007 to Access Voice Messages (IMAP Users)

To Create and Configure an Account in Outlook 2010 and later to Access Voice Messages (IMAP Users)

Procedure

Step 1 Start Outlook.
Step 2 On the File tab, select Info, then Add Account.

Step 3 Confirm that Email Account (the default) is selected, then enter user information:
a) In the Your Name field, enter a display name for the account. This typically is the full name of the user.
b) In the Email Address field, enter the Connection SMTP address of the user.

The address is available in the SMTPAddress field on the User Basics page in Connection Administration, and typically
uses the following format:

<username>@<SMTP domain name of the Unity Connection server or cluster>

c) In the Password field, enter the user’s Cisco PCA password (also known as the web application password).
d) In the Retype Password field, enter the Cisco PCA password again.

Step 4 Select Next.
Step 5 If you see the “Problem Connecting to Server” message about an unavailable encrypted connection: Select Next to use an

unencrypted connection.
Step 6 When the email-account configuration is complete, select Finish

If Outlook 2013 is getting crashed when you click on Draft Message/Sent Message/Calendar/Contacts, make sure
that the IntResource64.dll library file does not exist in the %temp%\AppData\Local\Temp\folder. If the file exists
in the specified location, delete the file before starting Outlook to resolve this issue.

Note

To Create and Configure an Account in Outlook 2007 to Access Voice Messages (IMAP Users)
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Procedure

Step 1 Start Outlook.
Step 2 From the Outlook Tools menu, select Account Settings.
Step 3 In the Account Settings dialog, on the Email tab, select New.
Step 4 In the Add New Email Account wizard, selectMicrosoft Exchange, POP3, IMAP or HTTP as the email service, then

select Next.
Step 5 Enter user information:

a) In the Your Name field, enter a display name for the account. This typically is the full name of the user.
b) In the Email Address field, enter the Connection SMTP address of the user.

The address is available in the SMTPAddress field on the User Basics page in Connection Administration, and typically
uses the following format:
<username>@<SMTP domain name of the Unity Connection server or cluster>

c) In the Password field, enter the user’s Cisco PCA password (also known as the web application password).
d) In the Retype Password field, enter the Cisco PCA password again.

Step 6 Select Next.
Step 7 If you see the Problem Connecting to Server message about an unavailable encrypted connection: Select Next to use an

unencrypted connection.
Step 8 When the email-account configuration is complete, select Finish.

Downloading ViewMail for Outlook 11.5(1)
To Download ViewMail for Outlook 11.5(1)

Procedure

Step 1 On a computer with a high-speed Internet connection, go to the Voice and Unified Communications download page at
http://www.cisco.com/cisco/software/navigator.html?mdfid=280082558.

To access the software download page, you must be signed in to Cisco.com as a registered
user.

Note

Step 2 In the tree control on the download page, expand Products > Unified Communications> Unified Communications
Applications>Messaging>Unity Connection, and select Unity Connection ViewMail forMicrosoft OutlookVersion
11.5.

Step 3 In the Latest Releases folder, select VMO 11.5(1).
Step 4 On the right side of the page, select Download Now, and follow the on-screen prompts to complete the download.

Customizing ViewMail for Outlook Setup
The file AdminConfig.xml is available in the ViewMail for Outlook installation folder. Use the file to prepopulate user and voicemail
server information when the ViewMail for Outlook installation or upgrade is being pushed out to users.
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After entering information in AdminConfig.xml, leave the file in the ViewMail installation folder when you make it available to
users.

Installing or Upgrading to ViewMail for Outlook 11.5(1)
By default, ViewMail for Outlook files are installed in the directory C:\Program Files\Cisco Systems\ViewMail for Outlook. You
can specify a different directory during the software installation.

Do the procedure in this section to install or upgrade ViewMail for Outlook on user workstations. Youcan also install ViewMail for
multiple users who share a workstation.

To Install or Upgrade to ViewMail for Outlook 11.5(1)

Procedure

Step 1 If Microsoft Outlook is running, exit the application.
Step 2 In the ViewMail folder, double-click the applicable file:

Use this file for new installations and for upgrades from
versions earlier than 11.5(1) It installs prerequisite software,
as needed; places the AdminConfig.xml file in the correct
location; and uninstalls older versions during upgrades.

This folder consists of two sub folders:

•Win32: If you need to install 32-bit ViewMail for
Outlook.

• x64: If you need to install 64-bit ViewMail for Outlook.

For silent installation of ViewMail for Outlook, in
AdminConfig.xml file, the user id should be the login
name of the system whereas the username and
password should be the user name and password of
Cisco Unity Connection.

Note

Setup.exe

Use this file for quick minor upgrades for ViewMail 32-bit
with versions 11.5(1) and later.

ViewMail.msi

Use this file for quick minor upgrades for ViewMail 64-bit
with versions 11.5(1) and later.

ViewMail_64.msi

Step 3 Follow the on-screen prompts to complete the installation.
Step 4 Restart Outlook.

Installing ViewMail for Outlook 11.5(1) Using Command Line Switches
To install ViewMail for Outlook 11.5(1) through command line switches:
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Procedure

Step 1 Run the following command on command prompt:
<Path of the VMO setup directory>setup.exe /i /qb /logfile <File Name>

<File Name> is the name of the log
file.

Note

Step 2 Restart Outlook.

Associating the Applicable Email Account with the Voicemail Server

If you are upgrading ViewMail for Outlook from 8.5(x) to a later version, skip this task as the existing
email account and ViewMail settings remain unchanged during an upgrade.

Note

You must link the applicable IMAP account or Exchange account with the voicemail server. This ensures that messages composed
by using ViewMail for Outlook are sent to the voicemail server.

Do the following procedure on each user workstation.

To Associate an Email Account with a Voicemail Server

Procedure

Step 1 In Outlook, open the ViewMail Settings or Options dialog:
On the ViewMail tab, select Settings.Outlook 2010 and above

From the Tools menu, select Options, then the ViewMail tab.Outlook 2007

Step 2 Select Add, then select the account to associate with a voicemail server.
Step 3 Enter the applicable information in each field:

sa
Select the voicemail server type to associate with the email
account.

In IMAP account, Cisco Unity Connection 7.x and
8.x versions support Unity Connection 7.x and 8.0.x
voicemail server type and Cisco Unity Connection
8.5 and later versions support Unity Connection 8.5
(IMAP) voicemail server type.

Note

Voicemail Server Type

Enter the Cisco Unity Connection username (alias) of the user.Username

Enter the user’s Cisco PCA password (also known as the web
application password).

Password

Enter the name of the voicemail server.Voicemail Server Name
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Display only.

(Possible values are “Connected,” “Not Connected,” “Invalid
Credentials,” and “Unknown.”)

Voicemail Server Status

Enter the extension or a phone number for the user.

This setting is required only if you want Unity Connection
users to be able to record or play messages by using the phone.

Phone Number

Select the preferred device.Recording Device

Select the preferred device.Playback Device

Step 4 Select Test Settings to verify the information that was entered.
Step 5 Select OK.

Limitations and Restrictions
•

Incompatibility with Exchange System Management Tools
ViewMail for Outlook version 11.5(1) does not work correctly when it is installed on a computer that also has Microsoft Exchange
System Management Tools installed.

Installing a New Version of Outlook Requires Uninstalling ViewMail First
When installing a new version of Microsoft Outlook on user workstations, you must first uninstall ViewMail for Outlook. After you
have installed Outlook, reinstall ViewMail.

Otherwise, ViewMail for Outlook will seem to be installed properly with the new version of Outlook, but it may not work.

Message Sensitivity Displays as Blank for Normal Sensitivity Messages Recorded in ViewMail
Users whose Outlook clients are configured to display the Sensitivity field in the message-list viewmay notice that messages recorded
in ViewMail for Outlook with the Sensitivity set to Normal do not display any text in the Sensitivity field.

Messages recorded by using the Cisco Unity Connection phone interface (as well as email messages composed in Outlook) display
“Normal” in the Sensitivity field.

Some Software on User Workstations Can Cause ViewMail to Fail
Some security and VPN software installed on user workstations may cause ViewMail for Outlook to fail. In particular, software that
offers personal firewalls is problematic.
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Exceptions may need to be added to the problematic software to allow ViewMail to work. Alternatively, you can set up ViewMail
so that users can play messages with audio devices on their computers.

In ViewMail for Outlook 11.5(1) and later, if the user connects or disconnects the audio devices, it is
recommended to restart Outlook, so that ViewMail for Outlook displays the status of currently attached
recording and playback devices only.

Note

Unity Connection Server Must Be Available to Compose Voice Messages
In order to compose voice messages by using ViewMail for Outlook with Cisco Unity Connection 8.5 and later, ViewMail must be
able to contact the Unity Connection server. If the server is not available, users will see the following message: “The requested action
could not be performed because the voicemail server was not available.”
In earlier ViewMail versions, voice messages could be recorded while the Unity Connection server was unavailable and were sent
when the server became available again.

ViewMail for Outlook 11.5(1) Limitations Regarding Reply and Forward Cisco Unity Voice Messages
In Unity Connection, users cannot reply to, or forward Cisco Unity voice messages or .wav files by using ViewMail for Outlook
version 11.5(1).

ViewMail for Outlook 11.5(1) Limitations Regarding Icon Update when a Voice Message is read
or unread
When a voice mail is marked read or unread using ViewMail for Outlook 11.5(1), the state of voice mail Icon is not updated regardless
of the Microsoft Outlook version.

ViewMail for Outlook 11.5(1) Limitations Regarding Cisco Unity 5 Message Playback
When playing a Cisco Unity 5 message using ViewMail for Outlook with "VMO Play Attachment" feature, audio progress bar is not
updated and time duration is not displayed on the ViewMail audio pane of the VoiceMail.

ViewMail for Outlook 64-Bit Limitation Regarding G.729
ViewMail for Outlook 64 bit version is not supported for G.729 codec.

ViewMail for Outlook Limitation Regarding Secured Voice Message Play with OpenAM SSO
If OpenAM Single Sign-On for Cisco PCA is enabled in ViewMail for Outlook, we recommend not to play the secure messages. If
you still play the secure messages after enabling OpenAM Single Sign-On, VMO displays the “Loading Audio” prompt and never
plays the audio message.

To play secure messages using ViewMail for Outlook with OpenAM SSO configuration, perform the following steps:

1 In Cisco Unity Connection OS Administration, disable SSO for REST API.
2 Create a rule that puts "/ciscopca/unitymessageserver/ums.do?*" in the "Not Enforced URI" rule section of OpenAM.
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The limitation of secured voice message play with OpenAM Single Sign-On is not applicable for Cisco
Unity Connection Release 11.x.

Note

Caveats
You can find the latest caveat information for Cisco Unity Connection ViewMail for Microsoft Outlook version 11.5(1) by using
Bug Toolkit, an online tool available for customers to query defects according to their own needs.

Bug Toolkit is available at http://www.cisco.com/go/bugs. Fill in your query parameters by using the custom settings in the Advanced
Settings option.

To access Bug Toolkit, you must be signed in to Cisco.com as a registered user.Note

Release notes for all versions of ViewMail for Outlook are available at http://www.cisco.com/en/US/products/ps6509/prod_release_
notes_list.html.

Open Caveats—Release 11.5(1)
This section lists the open caveats that includes open CFDs (Severity 1, 2, 3, 4, and 5) and IFDs (Severity 1, 2, and 3) when ViewMail
for Outlook version 11.5(1) was released. Select a link in the Caveat Number column to view the latest information of the caveat in
Bug Toolkit. (Caveats are listed in order by severity, then by component, then by caveat number.)

DescriptionSeverityComponentCaveat Number

Memory leak through VMO with Outlook 2010 for SIB3vmoCSCux45994

Resolved Caveats—Release 11.5(1)
There is no resolved caveat in ViewMail for Outlook version 11.5(1) release.

Obtaining Documentation and Submitting a Service Request
For information on obtaining documentation, submitting a service request, and gathering additional information, see the monthly
What’s New in Cisco Product Documentation, which also lists all new and revised Cisco technical documentation, at: http://
www.cisco.com/en/US/docs/general/whatsnew/whatsnew.html

Subscribe to the What’s New in Cisco Product Documentation as a Really Simple Syndication (RSS) feed and set content to be
delivered directly to your desktop using a reader application. The RSS feeds are a free service and Cisco currently supports RSS
Version 2.0.
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